
 

3

              
Chapter 3
Introductory Tour of 
SoundDiver

This document is a chapter of SoundDiver’s printed documentation,
adapted to the OEM versions of SoundDiver, and with removed pic-
tures. You can order the printed user manual (about 350 pages) from
your Emagic distributor.

We have prepared a brief tour of SoundDiver so that you can get to
know the program as easily and quickly as possible. During the trip you
can make a short stop at each station and carry out a few practical ex-
periments with SoundDiver.

We recommend that you spend half-an-hour doing this as it will save
you a lot more time later. In the meantime, you’ll get an overview of
the program before getting submerged in the details.

Before starting the tour you should:

❏ install SoundDiver

❏ connect the device supported by this OEM version of SoundDiver

❏ have at least 100 KB available storage space either on a floppy or 
hard disk because we are going to create a library.

The device used in most of the examples is the Roland JV-80. The
Yamaha SY77 and the Korg 01/W are also used. Of course, you don’t
have to use any of these devices. The operation of the OEM version of
SoundDiver is similar.

Off we go…

3.1 Station 1: Start

We begin the tour by double-clicking SoundDiver’s program icon.
SoundDiver starts up. First, you have to configure your ports. 
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Scanning
During the scanning operation, SoundDiver examines all the MIDI
ports to see if a certain device is present. It does this by first loading the
module or adaptation and then sending MIDI »Requests«. If a device
answers it is installed by SoundDiver and is then available for use.

SoundDiver OEM starts the scan process automatically at your first
startup. In case you have connected your device differently or changed
its device ID, SoundDiver will complain that it has not found it and offer
a »Re-scan«.

Window operation
Before we cover the actual Setup functions, you should get to know the
main functions relating to window configuration. These functions are
available in SoundDiver’s Library, Memory Manager and Setup win-
dows.

Window layout
On the left side of the Memory Manager window is the parameter box.
It displays the parameters of the currently-active device and allows you
to adjust these to suit your taste and system’s idiosyncrasies.

In the upper left corner of the parameter box is a small triangle. Click-
ing this will enlarge or shrink the parameter box. This function is also
available in other SoundDiver windows.

Now move the mouse pointer over the vertical dividing line down the
left-hand border of the icon region. The pointer will turn into a double-
arrow symbol. Hold down the mouse button and move the mouse left
and right. Using this method you can quickly adjust any SoundDiver
window to suit the situation. Return the dividing line to its original po-
sition.

Local menus
Most windows in SoundDiver contains a local menu bar with functions
relating solely to that window. The main menu bar remains visible and
its functions are available if you need them.

Now choose »Parameters« from the local »Options« menu. The param-
eter box disappears leaving the whole window free for the Memory
Manager. If you choose »Parameters« again the parameter box reap-
pears.
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Moving the contents of the window
In other programs you will have come across the scroll bars which are
situated along the lower and right-hand edges of the window. In
SoundDiver they are easier to use, since the contents of the window
move at the same time as you drag the scroll boxes so you always know
where you are.

Click anywhere in the empty area of the scroll bar opposite the box.
The contents of the window are moved exactly one page in the appro-
priate direction.

The x/y scroll gadget (the small box at the lower left corner of the win-
dow) is a unique SoundDiver convention. Click-holding the small box it
the lower left corner of any window allows the simultaneous move-
ment of the window’s visible section in horizontal and vertical direc-
tion.

Parameter box
The Memory Manager window and its parameter box is where you set
the parameters for your device: SoundDiver will observe these when it
communicates with the device.

First, we will give the Microwave a new name so it can be clearly iden-
tified. Click the name line in the parameter box and a text field will ap-
pear. Type in »Waldorf 1« (note that entering w replaces the previous
contents by a W). If you then press R, the name will be entered. We
will cover all the other parameters of the parameter box when we get
to Chapter 5 The Setup Window from page 165.

On we go to the next station…

3.2 Station 2: the Memory Manager

The Memory Manager is an exact depiction of the memory contents of
an individual device.

Contents of the Memory Manager
The Memory Manager displays all the memory locations for sounds,
multi-sounds, edit buffers, drum kits and any other data controlled by
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the device either internally or on a card. SoundDiver can thereby fully
exploit all the MIDI options of the device.

By virtue of »Entry Link Management« SoundDiver can recognize
whether the entry that is currently being edited (e.g. copied or moved)
is being used by another entry, and ensures that these cross-references
remain intact.

EXAMPLE: if you are moving a sound which is being used in a multi set-
up, SoundDiver will automatically update the corresponding parame-
ters in the multi setup so that these will continue to use the right
sound. This means that you can move your sounds wherever you want,
and SoundDiver will take care of the rest.

SoundDiver makes it easy to recognize these entries by displaying
them in bold type.

Let’s have a closer look at the Memory Manager. For the following ex-
periments you need a MIDI keyboard with a synthesizer. We will use the
Roland JV-80, but the experiments can be carried out on any MIDI key-
board. Open the Memory Manager by double-clicking the symbol for
your device in the Setup window. The Memory Manager will initially be
empty.
Of course, SoundDiver first needs to receive the memory contents of
the keyboard which will then be used as the basis for the experiments.

Requesting the memory contents of the devices
Choose »Select all« in the Edit menu. All the locations in the Memory
Manager will be displayed black which means they have been selected.
Now choose »Request« in the MIDI menu. A dialog box appears saying
»Receiving data from…« and a small bar indicates the progress of the
transfer. You can also see the Memory Manager filling up with entries.

NOTE: even though the Memory Manager usually contains the sounds
of a synthesizer this instruction manual always talks in terms of »en-
tries« rather than »sounds«, since entries can also be effects programs
from reverbs, etc. An entry in the Memory Manager could also be a sys-
tem setup or an edit buffer, and in this case »sound« would not be the
correct description.

Take a close look at the Memory Manager window: on the left is the de-
vice parameter box which you will recognize from the Setup window.
The Memory Manager displays all the memory locations of the device.
Use the scroll bars or x/y scroll gadget mentioned previously to access
items that are currently out of view.
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Saving the memory contents of the devices
As mentioned, the Memory Manager is an exact depiction of the de-
vice’s internal memory (also the card memory if available). This means
that when you are working in the Memory Manager you are directly ac-
cessing the memory contents of your device and you could accidental-
ly erase data. We therefore want to play it safe and let SoundDiver re-
ceive the entire memory contents of your devices and save them onto
disk. We will cover the individual steps in detail in a moment but for the
time being just follow the instructions below:

❏ choose »Build library« in the local Entry menu of the Memory 
Manager window. SoundDiver will now request the data of the 
device – if this was not done in the previous section – and creates 
a library

❏ now choose »Save« in the File menu. You can now save this new 
library onto disk.

Even if you accidentally alter the memory contents of your devices dur-
ing the following exercises – although SoundDiver warns you of this
wherever possible – you now have a safety copy with which you can re-
store everything to its original state.

Selecting entries
There are several different ways of selecting entries or groups of en-
tries.

The Memory Manager is divided into the individual data types (in this
case setup, performances and patches). Every area has its own small
grey title bar.

Click one of these title bars and the relevant area will be selected. Click
a column title bar in the patch bank and just this column will be select-
ed.

Choose »Toggle« in the Edit menu and all entries will be selected except
those that were previously selected. Now click anywhere in the grey
area and the selection will be cancelled.

Select a single entry by clicking it. Hold down S and you can select
other entries as well.

At this point we will try out another function: press the letter e and
watch what happens. SoundDiver selects the first entry whose name
begins with an »E«. If there are no entries beginning with »E« the follow-
ing entry in the alphabet is selected. Now press T and the next entry
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in alphabetical order will be selected. Pressing ST will take you in the
opposite direction.

Auditioning the selected entries
To transfer an entry from the Memory Manager to the appropriate edit
buffer in the relevant synthesizer, just click it with C held down.

If you want, you can have every selected entry sent automatically to
the device, providing a very quick and convenient way to audition se-
lected sounds. 

To enable this feature simply choose »AutoSurf« in the MIDI menu.
Now simply click an entry – the mouse arrow changes into a small MIDI
plug and you can try out the sound on the keyboard. If you choose
»AutoPlay« in the MIDI menu as well, SoundDiver will also transmit a
test note which is useful if your synthesizer doesn’t have a keyboard or
you can’t reach it from the computer.

Moving and copying entries
In the Memory Manager you can copy, move, initialize or delete the en-
tries if you want to sort your sound bank or compile a new bank from
several other banks. You can also copy entries between Memory Man-
ager windows as long as they originate from identical devices.

NOTE: in this case SoundDiver can automatically recognize whether
the data is convertible if you are dealing with related devices. So, for
example, you could copy entries between a D-50 and a D-550 or even
between an M1 and a T1 or a DX7 and an SY77. You can also copy en-
tries within a library using the mouse (we will cover this later).

WARNING: the following exercise will alter the memory contents of
your device.

Grab an entry with the mouse and move it to another location. Make
sure that you stay within the same bank, i.e., don’t move a sound pro-
gram to a system setup or a performance to a drum kit. If you just
move an entry onto another entry they will be swapped round.

You can reverse this operation by choosing »Undo« in the Edit menu or
by pressing Cz.

If you want to duplicate an entry hold down O while you drag the en-
try to its destination position. You can also reverse this operation.

What if you want to initialize a sound or a performance? No problem.
Simply select the relevant entry or entries and choose »Initialize« from
the local »Entry« menu of the Memory Manager. SoundDiver will then
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set all the parameters of the entry to neutral values. This is equivalent
to the initialize function that is found in many synthesizers and other
devices.

We now go to the next station: the library.

3.3 Station 3: the library

A library in SoundDiver is a sort of data bank for sounds and other stor-
able data from your MIDI devices. As in a data bank, you can find, sort,
delete and copy entries according to certain criteria.

A SoundDiver library uniquely allows you to gather together programs
from different devices: patches from a Roland JV-80, voices from a
Yamaha SY77, effects programs from an Alesis Quadraverb – all these
can be simultaneously stored in a single library (however OEM versions
of SoundDiver can handle only data of one device). There are different
ways of compiling libraries.

In the section Saving the memory contents of the devices on page 88 in
this chapter you created a library and saved it onto disk. We now want
to turn our attention to this library.

NOTE: because libraries (unlike the Memory Manager) are saved onto
disk, you can easily undo all the editing that you have done since the
last time you saved, simply by loading the library back into SoundDiver.

Copying entries from the Memory Manager into 
the library
Please choose »UNTITLED« from the »Library« category of the Windows
menu.

Click the full size gadget in the upper right corner of the Library win-
dow so that it fills the screen.
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User-definable configuration of the Library 
window
As you can see the Library window displays not only the names of the
entries but also a range of important data for each entry which you can
use to search, sort or simply distinguish the entries one from another.

Before we take a closer look at the details of the Library Window, let’s
alter its display a bit. For example, at the moment we don’t need to
view the comments column so let’s get rid of it. Choose »Comment« in
the local Show menu which previously had a tick beside it. The com-
ment column disappears and the columns to the right of it move left-
wards. Now do the same with the date, since, at the moment, the date
of the entries in the library is identical.

Sorting
We are now going to alphabetically sort the library display according
to the names of the entries. There are two ways to do this. You may ei-
ther double-click the »Name« field in the title bar or choose »Name« in
the local Sort menu.

Next, try sorting the library display according to »Data type« and
»Size«.

Moving columns and altering their widths
Would you rather have the model column on the left? No problem.
Grab the caption »Model« in the title bar and move it over the caption
»Name«. The columns will then be swapped.

Is the »Used by…« column too wide for you? Just click-hold the right
edge of the field in the title bar and drag left when the mouse pointer
turns into a double arrow.

You can alter the list display at any time so as to give yourself the best
possible overview.

Mixed libraries
One of the greatest advantages of SoundDiver libraries is that you can
manage entries from different devices within one library. If you have
more than one MIDI device and you have installed them in the Setup
window, your library will already be mixed because it will contain data
from the different devices. If you want to gather together all the en-
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tries belonging to a certain device, just sort them according to »Mod-
el«.

Dividing a library into zones
You can also divide any library into zones which can each be given an
appropriate title. The sort functions will then automatically work with-
in a zone. To demonstrate, try sorting your mixed library by model.
Now locate the point where the entries for the next device begin and
select the first entry for this device.
Choose »Insert title« from the local Library menu. A text field will then
open in which you should enter the following: »Memory contents of
<device name>«. Now sort the names alphabetically. You will see that
SoundDiver alphabetically sorts the zones separately above and below
the title.

Delete the title again by selecting it and pressing B.

Find functions
Even the best library is of no use unless you can quickly locate specific
sounds or other entries. SoundDiver therefore offers a range of Find
functions which will help you find what you are looking for straight
away, whether it is the right piano sound or all JV-80 performances –
even in the largest libraries.

Let’s imagine that you want to see if there are any bass sounds in your
library. Initially we have to use the name for the Find, i.e. we ask Sound-
Diver to find entries whose names contains the syllable »bas«.

Choose »Find« in the Edit menu. A window appears in which you enter
the characters. Type in »bas« and click »Find«. SoundDiver will find the
first entry in the library that matches the criterion and select it. Now
close the Find window.

Activate »AutoPlay« and »AutoSurf« in the MIDI menu.

Now choose »Find again« in the Edit menu or press Cg.

If there is another bass sound, SoundDiver will find it, send it to the de-
vice and play it. You can keep repeating the »Find again« function until
you have found all the bass sounds in the library.

What if you want to search according to completely different criteria?
Say you want to transfer all the data that comes from the 01/W from a
mixed library to a new separate library.
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To do this open the Find window either via the menu or by pressing
Cf and click »More Options«. Here you should enter the the text »01/
w«:
SoundDiver now searches for entries that originate from model 01/W
and simultaneously selects all the entries it finds. You can use standard
cut and paste functions to transfer these to another library or copy
them by dragging them with the mouse.

It’s time to dive deeper with SoundDiver and explore some of the
unique editing capabilities it offers.

3.4 Station 4: The Editors

The principle is easy to explain: every module and most of the adapta-
tions in SoundDiver which already use the Memory Manager, Setup
and Library also have a complete editor for the relevant device.
You will probably already be familiar with the term »editor software«.
In the past, a program like this was often specially-written for a specific
device. There was a DX7 editor, a Korg M1 editor and so on. If you used
several devices, you had to load a different program for each device. A
few years ago this may have not been such a problem since the average
setup did not usually contain many devices.

In a larger MIDI setup consisting of many smaller synthesizers plus ef-
fects and MIDI patchbays, this process is too cumbersome. Say you
have just finished a session and you want to store the sounds of all your
devices in the computer. You would have to load a device’s relevant
program, save its sounds, load the program for the next device and so
on…

SoundSurfer already allows you to organize your sounds universally for
all devices. During a production session, however, you often need to
change or edit the sounds in an arrangement, with the sequencer run-
ning if possible, and without having to continually start and quit pro-
grams.

SoundDiver allows you to do just that. You can simultaneously open
several editors, each of which contains several windows offering differ-
ent views of the sound parameters. This enables you to zoom in on the
envelope of an 01/W on the screen, while another window will show
you the complete effects section.
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The storable window configurations let you make optimum use of
these options, even on small screens.

Let’s start…
Let’s edit a few things in the JV-80. To be on the safe side, make sure
that you’ve created a Backup Library of everything in the JV-80’s mem-
ory, so you don’t change anything permanently by accident. The pro-
cedure is similar to the one described in section Saving the memory con-
tents of the devices on page 88. First, open the JV-80’s Memory Manag-
er window.

… in the Library
Choose »Build Library« from the local »New« menu of the Memory Man-
ager window. This one has a sub-menu where you can select specific
groups of entries:
We want to select all entries, so (surprise, surprise) choose »All En-
tries«.

SoundDiver automatically carries out a number of operations: it re-
ceives the sounds, creates and opens a new library and then copies the
received entries into it.

Welcome to pleasure-programming…
If you click an entry in SoundDiver it opens the editor where you can
immediately begin modifying the sound! 

❏ first activate the »AutoSurf« and »AutoPlay« options in the MIDI 
menu

❏ double-click a sound to open the editor. Experiment at random 
with the various operating elements – move the sliders, redraw 
the envelopes and switch the functions on and off. You will be 
able to simultaneously audition your editing

❏ quit the editor by clicking the close box of the window.

If you like the result of your random programming, click »Store« in the
dialog box that appears. You can also select a different location for the
edited sound in the flip-menu of the dialog box. On this occasion, it is
probably safer to click »Don’t Store«.
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A handful of editing functions…
We are now going to experiment with the editor in more detail. Have
you connected a device and opened the editor? If so, you should be
able to see an editor window.

Here you can see the Overview that initially appears with more com-
plex devices. This shows you all the elements of a sound or program at
a single glance.

In the top half, you’ll find several macro parameters that can be used
to edit the sound quickly and easily. This is the »Easy Page«.
Use these to edit a sound without having to go into too much detail. In
the example given in the diagram, the cutoff frequency was raised, the
resonance lowered slightly and the attack lengthened.

Say we wanted to edit the filter envelope for tone 1. Click this button in
the Overview display, and SoundDiver switches to the »detailed dis-
play«.

Basically you can view a SoundDiver editor like a street map. The Editor
window is a view of a certain section of this map. The Overview, on the
other hand, is the entire map in a larger scale.

In the detailed display, you can see every parameter of the device, al-
though compared to the device itself, these are presented in a far more
convenient and manageable form. Envelopes may be edited graphical-
ly, and there are knobs, beam displays and flip-menus.
In every editor you can open several windows showing whatever sec-
tion you want. This can be very useful, for example, when you want to
see just the left and right edges of the detailed editor at the same time.
Instead of continually scrolling back and forth between the two sec-
tions, just open a second window by choosing »Open Editor« from the
global Windows menu. Position this next to the first and scroll to the
desired section. Another example might be if you want to simultan-
eously see the overview and the detailed display of a sound, as shown
in the diagram. No problem, open two windows and set each view ac-
cordingly.
The switchable screensets allow you to instantly call up the different
editor displays.

If you don’t know what a parameter means, just click it and press H.
SoundDiver’s On-line Help will immediately display the relevant infor-
mation.
But that’s not all! The functions of the Edit menu are also available in
the editor. This means that the sound components and parameter
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groups may be copied at will, even between different entries. Just click
a parameter group with S held down to select it.
The above diagram shows a selected envelope. You can use the copy,
cut and paste functions of the Edit menu to copy it via the Edit Buffer
into other components of the sound (tones, elements, voices) and of
course into other sounds.

Randomize
If you don’t have the urge to program yourself or you need some cre-
ative impetus, try SoundDiver’s randomizing function. Not only can it
create entire sounds by chance, but also individual parameter groups.
A random envelope in an effect sound, a random new wave form in a
pad sound – and the sound becomes unrecognizable.

3.5 Station 5: the On-line Help

SoundDiver has a comprehensive, built-in On-line Help function. This
amounts to an individual instruction manual for the modules and ad-
aptations and describes the characteristics of each one. The On-line
Help is interactive and context-sensitive. That sounds a bit complicated
but means in practice that SoundDiver will always supply you with the
appropriate help text for the situation at hand. Let’s try it out now.

Call up the Setup window and position it so that it occupies the left half
of the screen. Now choose »Help« in the Windows menu or press the
H key.

You should get into the habit of using the On-line Help function when
you encounter a problem. Select one of your devices in the Setup win-
dow and have a look at all its help messages. Familiarize yourself with
the different topics. Now, when you get into trouble, you will immedi-
ately know where to find the information which may solve your prob-
lem.
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3.6 Other functions

The mini-sequencer
An important component of SoundDiver is its mini-sequencer. It is not
intended for recording complete MIDI songs, but it gives you the pos-
sibility of recording a melody or phrase which you can use to test out
sounds.

You open the sequencer by choosing »Sequencer« in the Windows
menu. The sequencer window is a »floating« window which always re-
mains in the foreground and cannot be moved to the background even
when you activate another window.

Check that your MIDI keyboard is connected properly by playing a few
notes on it. If the sequencer is receiving notes a bar will appear in the
field previously labelled »NO IN« in the sequencer window, and note in-
formation will be displayed.

In the lower part of the sequencer you will see the transport buttons
which look similar to those on a cassette recorder. Click the record but-
ton (upper right). You will now hear a metronome signal coming from
the loudspeaker of your computer; the counter of the sequencer keeps
repeating the first beat – the sequencer is in waiting mode.

Now play a short phrase of about four bars. Click the stop button (low-
er right) when your are done. The phrase will have been recorded. You
can listen to it by clicking the play button (below in the middle).

Call up the library or Memory Manager windows. If you have activated
»AutoPlay« and »AutoSurf« in the MIDI menu, as described above, an
entry will be sent to the MIDI device as soon as you click it and the se-
quencer will automatically play the test phrase.

Screen sets
SoundDiver stores the layouts of the windows and various other set-
tings as screen sets. You can assemble up to 90 different screen sets
and call them up via key commands. Your current screen set is »1«,
which is displayed in the main menu bar. If you now press the 2 key
you will see an empty screen and »2« will be displayed in the main
menu bar.

Now open a few windows and the sequencer as well.
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By alternately pressing 1/2 you can toggle between these pre-
defined screen sets. With the help of these recallable screen sets you
will always have an optimum overview, even on a small monitor.

3.7 Short introduction to SysEx

Don’t worry, you won’t have to deal with SysEx data – that’s what
SoundDiver’s for. However, we thought that a brief introduction
wouldn’t hurt. So if you’re interested, read on.

What is System Exclusive data?
SoundDiver controls sounds, combinations, programs – in short all the
saveable data of your MIDI device. This data differs from the standard-
ized MIDI commands like Note On, Aftertouch or Program Change be-
cause they are different for every device. A special data format was cre-
ated within the MIDI specification to deal with the transfer of device-
specific parameters: System Exclusive data.

There are two plausible explanations for the term »System Exclusive«:
it’s not certain which is »officially« correct. You can decide for yourself:

● System Exclusive data is the exception among MIDI data formats
because it is the only one that is not uniform for all devices

● System Exclusive data is intended to be exclusively for a specific sys-
tem (device, model) and is ignored by all other systems

SoundDiver communicates with its MIDI devices almost entirely on a
System Exclusive level. You will hardly be aware of this since Sound-
Diver’s orientation to the different devices is contained in the modules
and adaptations. To you, it may appear almost as if SoundDiver is ad-
dressing all the devices in the same way. This is exactly how it should
look, so that the operation of the devices is as uniform as possible and
works quickly and efficiently in practice. However, SoundDiver some-
times takes longer to receive the memory contents of device A than
device B.

The System Exclusive data format of a device is laid down by the man-
ufacturer with hardly any restrictions. This means that whereas one de-
vice may be able to send each sound individually, another one may not.
Even the amount of data used for a single sound varies greatly from de-
vice to device.
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There are a few special features of System Exclusive data which you will
come across in your work with SoundDiver, as follows.

Device IDs
Normally you distinguish between different devices within the MIDI
system by allocating them different MIDI channels. When dealing with
System Exclusive data, that is not always practical. For example, say
you want to put four synthesizers of the same model all on one channel
but with each one generating a different sound. In this case you need
to be able to distinguish between them on the basis of the devices
themselves – not MIDI channels.

For this reason, nearly all new devices and many older ones have their
own identifiable number for System Exclusive data – the »Device ID«.
SysEx-compatible devices within the system must have different IDs so
that they can be addressed individually. This means that you can indi-
vidually address considerably more than just sixteen devices at once
and you can even distinguish between identical devices – say several
DX7 modules in one TX816 rack. The device ID is totally independent
of the MIDI channel of the device. If a device treats the MIDI channel
and device ID separately, you only need to let SoundDiver know this ID
and from then on you don’t even have to keep the device on the same
MIDI channel.

Dump request
Nearly all MIDI devices can transmit their data on request. This is vital
if the computer is to be able to communicate with a device. For exam-
ple, when you choose »Request« in SoundDiver’s MIDI menu, Sound-
Diver transmits a dump request to the device asking it to send this data
to the computer. Depending on the device, there are different dump
requests for sound banks, individual sounds, performances, system
setups, drum kits etc. SoundDiver supports all types of dump requests
used by the different devices.

Dumps
A dump is a device’s response to a dump request – it contains the re-
quested sound data. Dumps are also used by SoundDiver itself, for ex-
ample, with the »AutoSurf« function. Many devices can initiate »active
dumps«. These are dumps from device to computer initiated by the de-
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vice itself, i.e. without any dump request having been sent. SoundDiver
can process active dumps at any time.

Parameter Changes
If you change a parameter in a SoundDiver Editor, SoundDiver uses a
»Parameter Change« message to inform the device. Of course, it could
just transmit a dump of the contents of the Edit Buffer. However, that
would take too long and would make real-time editing impossible. If
you are using SoundDiver together with a sequencer in a MIDI-tasking
system you can record parameter changes in the same way as control-
ler or pitch bend information.

Unfortunately, not all devices support parameter changes. In this case,
SoundDiver has to transmit a dump. To avoid this happening after ev-
ery small alteration (which would make the Editor unusable), the dump
is delayed until about a second after the last alteration in the Editor.

We hope that this chapter has not only shed some light on the subject
but also wet your appetite for more. So far, we have only skimmed the
surface of SoundDiver’s functions. In the following chapters you will
learn the details of all SoundDiver’s functions and capabilities.

We advise you to take the time to carefully read the remaining chap-
ters. It will only take a few hours. Of course, you won’t be able to re-
member everything at first. If you come across an unfamiliar term, look
it up in the index. We have endeavored to make this as extensive as
possible so that you have some support when you really need it. Initial-
ly, you should also make full use of the On-line Help which we covered
earlier.

In the next chapter you will learn how SoundDiver operates and also
touch on the main menu bar.
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Appendix A 
Summary of the Menus

A.1 Main menu bar

ð menu
About SoundDiver… opens the Info window that contains copy-

right, program version, author and date information
License Agreement… shows the license agreement of the OEM ver-

sion
SoundDiver Features… lists all features of SoundDiver (OEM and 

demo versions only)
Emagic Distributors… lists the addresses of all Emagic-Distributors 

(OEM and demo versions only)

File menu
New creates a new empty library
Open… opens an existing library
Close closes the active library
Save saves the library to disk
Save as… saves the library to disk, under a new name if de-

sired
Revert to saved reverses all alterations made to the library since the 

last save by loading the previously-saved version 
from disk

Page setup… opens the window that determines the print param-
eters

Print… starts the printout to the connected printer
Import… imports another program’s file into a SoundDiver li-

brary
Export MIDI File… exports the selected data as a standard MIDI
Preferences… opens the Preferences window
Save Prefs as… saves the preferences in a new file
Quit quits SoundDiver
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Edit menu
Undo reverses the last operation
Redo repeats the last operation
Cut removes the selected objects from the display and 

places them in the clipboard
Copy copies the selected objects in the display and places 

the copies in the clipboard
Paste copies the contents of the clipboard back into the 

display
Clear deletes the selected objects
Select all selects all objects in the top window
Toggle selects all unselected objects and vice versa
Find… opens the Find window for defining the Find condi-

tions and starting the Find operation
Find again repeats the Find operation using the same condi-

tions as before – avoids having to open the window 
again

MIDI menu
Request requests the selected entries from the device
Transmit sends the selected entries to the device
AutoSurf Ö: entries when clicked are automatically sent
AutoPlay Ö: entries when clicked are automatically auditioned 

using a test note
MIDI Thru Ö: received MIDI events are routed to the comput-

er’s MIDI output
All Notes Off sends the »All Notes Off«-command (e.g. to cut off 

droning notes)
Reset Controllers resets all Controllers
Maximum volume sets Controller 7 (Volume) to 127 on all channels 

and outputs
Capture MIDI File… saves all MIDI output in a standard MIDI file

Windows menu
Library opens a new window for the active library
Memory Manager opens a new Memory Manager window for the 

active device
Editor opens a new editor window for the selected entry 

(SoundDiver only)
Sequencer opens the Sequencer window
MIDI Monitor opens the MIDI Monitor window



Library window local menus

A

Help opens the On-Line Help window for assistance with 
references to the situation in hand

Next window brings the next window to the top of the stack there-
by activating it

Zoom window toggles between maximum use of the screen area 
and a definable window section, and positions the 
window so that it abuts the menu bar 

Close window closes the active window
Tile windows distributes all open windows so as to make best use 

of the screen area
Stack windows stacks the windows so they overlap
Library list shows which libraries are open; click a library name 

to activate it

A.2 Library window local menus

Library
Surf! sends the selected library entries to the correspond-

ing device
Dive! sends the selected library entries to the correspond-

ing device and opens an editor window (SoundDiver 
only)

Store sequence assigns the sequence stored in the mini-sequencer 
to the selected library entries

Insert title inserts a title entry ahead of the first selected entry. 
You then enter the title in the text field that auto-
matically opens

Insert file… inserts a SoundDiver library (or one from another 
program) before the selected entry

Show
No. … Uses each of these menu items toggles the display of the 

corresponding parameters on/off
All all parameter displays are enabled
None all parameter displays are disabled
Parameters Ö: entry parameter box on/off
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Sort
Name … Comment the library table is sorted according to the se-

lected menu item
auto the library table is automatically sorted after every 

library operation

A.3 Memory Manager local menus

Entry
Load and transmit file… loads a file (library or alien format) into the 

Memory Manager
Initialize initializes the sound parameters of the selected en-

tries
Rename opens a text field for the renaming of the selected 

entry
Surf! sends the selected entries to the device’s corre-

sponding edit buffers
Dive! sends the selected entries to the device’s corre-

sponding edit buffers and opens an editor window 
(SoundDiver only)

Options
Parameters Ö: devices parameter box on/off
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